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Safety Compliance

Safety Statement
This equipment has been tested to comply with USA and Canadian safety certification in accordance with the specifications of UL Standards: UL60065 7th /IEC 60065 
7th and Canadian CAN/CSA C22.2 60065:03. Avid Inc., has been authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Warning

Important Safety Instructions
1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Only perform the services explicitly described in the install and or user manual.  For services or procedures not outlined in the install or user manual, speak with 
authorized service personnel.

6) Do not use this equipment near water.

7) Clean only with dry cloth.

8) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.

9) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.

10) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug 
has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult 
an electrician for replacement of the obsolete outlet.

11) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.

12) Only use attachments/accessories specified by the manufacturer.

13) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a 
cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.

14) Unplug this equipment during lightning storms or when unused for long periods of time. 

15) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is 
damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has 
been dropped.

16) For products that are a Mains powered device: 
The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment. 

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture. 

17) For products containing a lithium battery: 
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type. 

18) The power inlet is the main disconnect device and should remain accessible. Disconnect the power cord before servicing the unit.

19) The equipment shall be used at a maximum ambient temperature of 40° C.

20) Disconnect power from mains before opening the product 
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Overview

This guide provides instructions for installing the following I/O cards in Stage 64 and Stage 32 I/O racks for VENUE | S6L systems:
• SRI-192 Analog Input card
• DSI-192 Digital Input card
• SRO-192 Analog Output card
• DSO-192 Digital Output card

Stage 64 supports installation of up to eight input cards (providing a maximum of 64 input channels) and up to four output cards 
(providing a maximum of 32 output channels). Stage 64s can be purchased empty, or in their base configuration of 48 in/8 out. 

Stage 32 supports installation of up to four input cards (maximum of 32 input channels), or up to four output cards (maximum of 
32 output channels), or any combination of input and output cards up to the maximum of 32 channels total. Stage 32s can be pur-
chased empty, or in their base configuration of 24 in/8 out. 

Stage I/O Card Features and Capabilities

SRI-192 Analog Input Card 
• Eight channels of analog mic/line inputs via XLR-3 female connectors
• +48V phantom power, 20 dB pad, and phase reverse (all selectable per channel via the control surface and VENUE software)
• Signal and phantom power LEDs for each channel
• 24-bit A/D conversion, up to 192 kHz sample rate

DSI-192 Digital Input Card 
• Eight channels of digital inputs via four two-channel AES/EBU XLR3-female connectors or a single ADAT TOSLINK 

optical connector
• Automatic sample rate conversion (SRC) and detection on input; manually defeatable for lowest possible input latency
• SRC and Lock status LEDs for both AES and ADAT connections
• Word clock output for synchronizing external digital devices

SRO-192 Analog Output Card 
• Eight channels of analog line outputs via male XLR-3 connectors
• Automatic muting for system protection
• Signal and Mute LEDs for each channel
• 24-bit D/A conversion

DSO-192 Digital Output Card 
• Eight channels of digital outputs via four two-channel AES/EBU XLR3-male connectors and/or a single ADAT TOSLINK 

optical connector
• Simultaneous output to both AES/EBU outputs and ADAT optical output
• Automatic muting for system protection
• Signal and Mute LEDs for each AES/EBU channel pair

For instructions on installing the DNT-192 Dante Option card, see the documentation included in its package.
 Overview 1



What’s Included
I/O card packages includes the following items:

• I/O card
• Health and Safety guide
• Avid Registration card
• Warranty claims card
• This guide

System Requirements and Compatibility
Avid can only assure compatibility and provide support for hardware and software it has tested and approved. 

• SRI-192, DSI-192, SRO-192, DSO-192, and DNT-192 cards are compatible with Stage 64 and Stage 32 racks connected to 
VENUE | S6L systems running VENUE software 5.0 and higher (Stage 32 requires VENUE software 6.0 and higher).

For complete system requirements and other compatibility information, www.avid.com/compatibility.

Conventions Used in This Guide
All of our guides use the following conventions to indicate menu choices and key commands:
:

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

Convention Action

Options > System In the VENUE software, click Options to display the Options tab, then click 
the System tab.

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse button

Right-click Click with the right mouse button

User Tips are helpful hints for getting the most from your system.

Important Notices include information that could affect your data or the performance of your system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other VENUE guides.
S6L Stage I/O Card Installation Guide2



Resources
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system. 
The following are just a few of the services and features available. 

Account Activation and Product Registration
Activate your product to access downloads in your Avid account (or quickly create an account if you don’t have one). Register your 
purchase online, download software, updates, documentation, and other resources. 

https://www.avid.com/account

Support and Downloads
Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Com-
patibility documents for system requirements; search the online Knowledge Base or join the worldwide Avid user community on 
the User Conference. 

https://www.avid.com/products/venue-s6l-system/learn-and-support

Training and Education
Study on your own using courses available online, find out how you can learn in a classroom setting at an Avid-certified training 
center, or view a webinar. For example, check out the live sound webinars hosted by Robert Scovill: 

http://www.avid.com/live-sound-webinars

Also check out our Live Sound blogs: 

http://www.avidblogs.com/livesound/

Get started learning the ins and outs of S6L using the many Avid Live Sound videos on YouTube. 

Products and Developers
Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and 
hardware. 

https://www.avid.com/Products/index.html
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Installing and Confirming I/O Cards

This section shows how to install an I/O card in the Stage 64 or Stage 32 I/O rack and confirm installation. 

Prepare the I/O Rack Unit
Do the following to prepare your Stage 64 or Stage 32 for IO card installation: 

1 Shut down your VENUE system and power down your Stage 64 or Stage 32. 

2 Disconnect all cables from your Stage 64 or Stage 32. 

3 Remove the back panel: 

Stage 64  Loosen the eight captive thumbscrews completely, using a #2 Philips screwdriver if necessary, and set the panel aside.

Stage 32 Loosen the four captive thumbscrews completely, using a #2 Phillips screwdriver if necessary, and set the panel aside. 

4 Make sure your work area provides access to the front and back of the Stage IO unit. 

To install a DNT-192 Dante Option Card, see the DNT-192 Option Card Guide included with the card. For operational informa-
tion for all racks and cards, see the VENUE | S6L System Guide.

Figure 1. Stage 64 back panel captive thumbscrews

Figure 2. Stage 32 back panel captive thumbscrews

AC~100-240V;60-50HZ;2.0AAC~100-240V;60-50HZ;2.0A

DO NOT OBSTRUCT FANS
SERIAL NUMBER
 Installing and Confirming I/O Cards 5



5 For Stage 32 (only), do the following: 
• Facing the front, set the unit onto its right end as shown below. This position makes it easier to slide cards in and out. 

Installing I/O Cards
After preparing the Stage IO unit you are ready to install cards. If you are adding new cards to slots that are currently empty, you 
are ready to begin. If you are moving or replacing IO cards, you must first remove cards. For instructions, see “Removing an IO 
Card” on page 11. 

To install an SRI, SRO, DSI, or DSO card: 

1 On the front of the Stage IO unit, locate the slot where you want to install the input or output card. 
Each slot is lettered, and corresponds to the card slot shown along the top of the VENUE Patchbay patching grid, depending on 
the type of card installed (input or output card). Observe the following requirements when installing I/O cards in Stage 64 or 
Stage 32: 

Stage 64  Slots are lettered left-to-right A–M. 
• Input Cards (SRI and DSI) must be installed in slots A–H. 
• Output Cards (SRO and DSO) must be installed in slots J–M.

Stage 32 Slots are lettered from top-to-bottom A–D (when the unit is positioned in its standard orientation, with the AVID logo 
across the bottom). 

• Input cards (SRI and DSI) are installed in lower lettered slots (physically above output cards). 
• Output cards (SRO and DSO) are installed in higher lettered slots (physically below input cards). 
For example, in its base configuration the 3x SRI Analog Input cards are installed into slots A, B, and C with the SRO Analog 
Output card in slot D.

Figure 3. Stage 32 positioned for IO card installation

DNT-192 Dante Network cards can be installed in any slot and configured in software as 16-in or 16-out. If configured for Dante 
output all I/O cards below the DNT-192 card (in higher lettered slots) must be output cards. For more information, see the 
DNT-192 Dante Option Card Guide. 
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2 Do either of the following, as appropriate: 
• If the desired slot has a blank slot cover, remove the slot cover by unscrewing the two Philips head screws that secure the cover 

to the Stage IO unit. In the following image, the slot cover in slot G of a Stage 64 is highlighted. 

• If the desired slot already has an IO card installed, see “Removing an IO Card” on page 11 and then return here to continue 
installing the new card. 

3 Remove the new I/O card from its packing material and hold the card by its edges. 

4 Make sure the latches on the port on the back of the card are pushed inward (closed) as shown in the figure, below.

Figure 4. Blank card slot cover on the front of the Stage 64

Figure 5. Stage 64 I/O card showing brackets and connector 

Make sure the port latches are pushed inward before proceeding. 
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5 Gently slide the card into the slot (Figure 6): 
• Make sure that the card is oriented correctly in the unit, with the mounting guide pin and port at the top. 
• Make sure to insert the card straight so that it fits along the slot channel built into the unit. 

• Inside the back of the unit, make sure the pin at the top of the card aligns with the corresponding chassis guide hole (Figure 7).

Figure 6. Sliding an SRI card into slot G of a Stage 64 (shown at left) and into slot D of a Stage 32 (shown at right)

Figure 7. Guide pins and guide holes inside the Stage 64
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6 Push the card into the slot so it is flush with the front panel, and tighten the two captive thumbscrews on the front of the card to 
secure it to the Stage unit.

7 Inside the back of the Stage unit, tighten the single captive thumbscrew to secure the card to the chassis.

If the card does not slide all the way into the slot, make sure the latches on the port of the card are pushed fully inward.

Figure 8. Tightening the front captive thumbscrews (Stage 64 shown)

You might need to disconnect some or all ribbon cables to access the thumbscrews. 

Figure 9. Securing the card to slot G of the Stage 64 chassis (shown at left) and to slot D of the Stage 32 (shown at right)
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8 Inside the back of the unit, push the latches on the newly installed card outward (open).

9 Connect (or reconnect) ribbon cable(s). 
• Locate the corresponding ribbon cable (all ribbon cables are cut to length), and push the cable connector into the port on the 

card so that the latches on the port move inward and lock the connector to the port on the card. Double-check to make sure the 
card is connected securely. 

• If you had to disconnect other ribbon cables, re-connect them starting with the first (shortest) ribbon cable. 

10 Replace the back panel on the Stage 64 or Stage 32:

Stage 64  Make sure to properly orient the panel, align the back panel guide pins to the guide holes, and secure it to the Stage 64 
by tightening the captive thumbscrews. 

Stage 32 Make sure to align the back panel and secure it to the Stage 32 by tightening the captive thumbscrews. 

11 Proceed to “Confirming Installation” on page 11.

Figure 10. Connecting the I/O card to its corresponding ribbon cable in Stage 64 (shown at left) and Stage 32 (shown at right)

Figure 11. Back panel guide pins (Stage 64 only)
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Confirming Installation
After you have installed an I/O card, you should confirm that you have installed it properly.

To complete and confirm installation:

1 Connect the power cables to the Stage unit and to a power source.

2 Connect the Stage unit to the rest of your S6L system.

3 Power on your Stage unit and the rest of the components of your S6L system.

4 In the VENUE software screen, go to the Options > Devices page.

5 In the Available Devices or Connected Devices columns, tap the icon of the Stage 64 or Stage 32 in which you installed the 
I/O card so it is highlighted in blue.

6 Under Information, tap Settings. The I/O card slots of the selected Stage unit are listed, showing the cards that are currently in-
stalled. Slots without cards are indicated as empty. 
The newly installed Stage I/O card should appear in the slot in which you installed the card.

Removing an IO Card
To remove an IO card: 

1 Follow the instructions in “Prepare the I/O Rack Unit” on page 5 to power down the unit, disconnect cables, and remove the back 
panel. 

2 Disconnect ribbon cables by first pushing both latches to the out (open) position, then carefully pulling the cable connect out of 
its card port. 
Depending on the current card configuration you might need to disconnect multiple ribbon cables to access the cable for the card 
you plan to remove. 

3 Loosen the captive thumbscrew securing the card to the chassis (see Figure 9 on page 9). 

4 Loosen the two captive thumbscrews securing the front of the card to the front of the IO unit (see Figure 8 on page 9). 

5 Carefully slide the card out of its slot. 
To get it started, gently push the back of the card towards the front of the unit. 

For instructions on using the Stage 64 and Stage 32, see the VENUE | S6L System Guide.pdf, included with the S6L system soft-
ware in your Avid account.
 Installing and Confirming I/O Cards 11
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Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste 
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste 
equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more 
information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the 
product.

Proposition 65 Warning

Perchlorate Notice
This product may contain a lithium coin battery. The State of California requires the following disclosure statement: 
“Perchlorate Material – special handling may apply, See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

EMC (Electromagnetic Compliance)
This model Artist Mix complies with the following standards regulating interference and EMC:
• FCC Part 15 Class B
• EN 55022 Class B
• EN 55024 Class B
• AS/NZS CISPR 22 Class B
• CISPR 22 Class B

This product contains chemicals, including 
lead, known to the State of California to 
cause cancer and birth defects or other re-
productive harm. Wash hands after handling.
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FCC Compliance for United States

Radio and Television Interference

Australian Compliance

Canadian Compliance
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

CE Compliance
(EMC, Safety, and ROHS)

Avid is authorized to apply the CE (Conformite Europenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 2004/108/EC, Low Voltage 
Directive 2006/95/EC and RoHS Directive 2011/65/EC.. 

Korean EMC Compliance

Communication Statement
NOTE: This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there 
is no guarantee that interference will not occur in a particular 
installation.  If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try and correct the 
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
Any modifications to the unit, unless expressly approved by Avid, 
could void the user's authority to operate the equipment.
S6L Stage I/O Card Installation Guide14





Avid
75 Network Drive
Burlington, MA 01803
Technical Support (USA)
Visit the Online Support Center 
at www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com
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